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Welcome to MSC.ADAMS

Thank you for purchasing MSC.ADAMS products. The

MSC.ADAMS® suite of software is the world’s most widely used
mechanical system simulation software. It enables users to produce
virtual prototypes, realistically simulating the full-motion behavior
of complex mechanical systems on their computers and quickly
analyzing multiple design variations until an optimal design is
achieved. This reduces the number of costly physical prototypes,
improves design quality, and dramatically reduces product
development time.

MSC.ADAMS is part of SimOffice™, MSC’s stand-alone VPD
environment. SimOffice provides a unified framework for
simulation of integrated virtual prototypes and includes other major
MSC product families, such as MSC.Nastran.

This guide introduces you to MSC.Software, what’s new in this
release of MSC.ADAMS, and how to run the products. It also
explains how to use the MSC.ADAMS online help. At the beginning
of the guide, you’ll find lots of resources for learning more about
MSC.Software and MSC.ADAMS, attending training, and obtaining
consulting services.
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About MSC.Software

Overview

MSC.Software Corporation is the leading global provider of virtual
product development (VPD) tools, including simulation software
and professional services. MSC.Software helps companies make
money, save time, and reduce costs associated with designing,
testing, producing, and supporting manufactured products.

MSC.Software works with thousands of companies worldwide, in
hundreds of industries, to develop better products faster by using
information technology, software, and services to enhance and
automate the product design and manufacturing process. Simulating
your product performance reduces development costs, time to
market, and warranty costs.

About Virtual Product Development and
MSC.ADAMS

You’ve heard it before: manufacturing companies today face intense
global competition, demanding customers, fragmented markets,
increasing product complexity, compressed product cycles, price
and profit pressures, strict regulatory and liability environments,
systems integration and supply chain issues, skyrocketing costs of
testing and physical prototyping, and on and on...

What you don’t often hear, though, is a strategy for enabling your
company to improve your new product development process to meet
these challenges.
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Whether you are delivering airplanes, automobiles, ships, biomedical devices, golf clubs
or children’s toys to your customers, MSC.Software’s goal is to help you improve your
new product development process, allowing you to be significantly better at your concept
development, design, testing, and production activities through the application of VPD.

VPD is an environment that uses an integrated combination of both simulation software
technology and traditional techniques to design, test, manufacture, and support products.
The result is that cost-effective designs that meet all performance, safety, durability, and
reliability requirements can be brought to market in less time and for less cost.

MSC.ADAMS, as part of VPD, is focused on enhancing your ability to make better
product development decisions, explore innovative design alternatives, and consistently
get the product right. It is the world's most widely used mechanical system simulation
software. It enables you to produce virtual prototypes, realistically simulating the full-
motion behavior of complex mechanical systems on your computers and quickly
analyzing multiple design variations until an optimal design is achieved. This reduces the
number of costly physical prototypes, improves design quality, and dramatically reduces
product development time.
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About Licensing MSC.ADAMS

MSC.Software offers you two methods of providing software: traditional (per seat) and
token-based (MSC.MasterKey):

= Traditional Method: In the traditional method, purchasing one product results
in one license (or seat) of that product; two purchases allows for two
simultaneous users. If a different software item is needed, you must purchase
new seats of the new software.

= MSC.MasterKey: With the MSC.MasterKey method, you purchase a pool of
tokens. Users in your company check out tokens from the pool and use them to
access and run the solutions available under MSC.MasterKey. Each individual
software requires a certain number of tokens to run. There are roughly 250
different software options available under MSC.MasterKey.

To learn more, go to:

http://lwww.mscsoftware.com/products/products_detail.cfm?PI=556

Contacting Us

Headquarters

Address: MSC.Software Corporation
2 MacAurthur Place
Santa Ana, CA 92707 USA

Web site: http://www.mscsoftware.com
Main number: (714) 540-8900
Customer Service: (800) 732-7284
Fax number: (714) 784-4056

For additional information, such as phone numbers for specific departments, maps, and
driving directions, go to:

http://www.mscsoftware.com/about/


http://www.mscsoftware.com/about/
http://www.mscsoftware.com
http://www.mscsoftware.com
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Sales and Service Offices

MSC.Software has sales and service offices throughout North America, as well as throughout
the world. Sales and service of MSC.ADAMS products are also handled by selected
distributors and value-added resellers (VARS) in various areas of the world.

For information about the sales and service offices, go to:

http://www.mscsoftware.com/about/locate/?Q=131&2=140

and then select a region.

Need Technical Support?

At the MSC.ADAMS support Web page
(http://www.mscsoftware.com/support/prod_support/adams/), you can read the latest release
notes and known issues and get information about available technical support. To find your
support center, go to:

http://www.mscsoftware.com/support/contacts/index.cfm.
In addition, we provide several excellent sources of online information:

= Knowledge Base - Find solutions to problems in this repository of troubleshooting
tips, examples, and frequently asked questions. To access the knowledge base, go
to:

http://support.mscsoftware.com/kb/

= VPD Community - The VPD community is where to go when you are looking for
peer support, as well as technical expertise. Many of our consultants, developers,
and technical support staff monitor the forums. To sign up for the forums, go to:

http://forums.mscsoftware.com
Then:
—1 To view the MSC.ADAMS discussions, select MSC.ADAMS.
1 To view product alerts and company news and events, select MSC News.


http://support.mscsoftware.com/kb/
http://www.mscsoftware.com/support/contacts/index.cfm
http://forums.mscsoftware.com
http://www.mscsoftware.com/support/prod_support/adams/
http://www.mscsoftware.com/about/locate/?Q=131&Z=140
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Need Training?

Throughout the year, MSC.Software offers many training options at locations throughout
the world. For training schedules, locations, and registration information, go to:

http://www.mscsoftware.com/support/msc_institute/

Using Consulting Services

MSC.Software offers a wide range of cost-effective engineering services, on both a short-
and long-term basis, when you need them, at your site or from our offices.

For information about the available consulting services, go to:

http://www.mscsoftware.com/services/.


http://www.mscsoftware.com/support/msc_institute/
http://www.mscsoftware.com/services/
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What's New

Overview

The MSC.ADAMS 2005 r2 release is the most advanced version of
MSC.ADAMS. It contains over 100 enhancements and many
corrections to the software. It introduces the new product,
ADAMS/SmartDriver, an advanced driver simulator.

Learn more about this new release:

Highlights of Product Improvements, 14
Platforms Supported, 15

Supported Versions of Integrated Products, 15
Platforms Supported, 15

Additions to Existing Products, 17

Highlights of Online Help Improvements, 53
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Highlights of Product Improvements
There are many reasons why you should use MSC.ADAMS 2005 r2, including:

Product Integration

Improved durability simulations in MSC.ADAMS through MSC.Nastran
integration

Common solver for multi-body, controls, and hydraulics applications
Validated MSC.ADAMS models reused in MSC.Nastran for NVH analysis
Improved connection between MSC.ADAMS and controls-systems software
ADAMS/SmartDriver (new product) support in ADAMS/Car

Road Builder (ADAMS/3D Road feature) support in ADAMS/Car and
ADAMS/Chassis

New Capabilities

Technology for analyzing rotating systems

Significantly faster contact simulations

Rudimentary flexible-body contact

Ability to view stress hot spots

Accurate modeling of distributed forces

Right turns for open loop and quasi-static cornering events in ADAMS/Car

Support for abort conditions in the Driving Machine and Event Editor for
ADAMS/Car and ADAMS/Chassis

Road Builder interface for ADAMS/3D Road

Other Additions

Continued migration of MSC.ADAMS applications to ADAMS/Solver (C++)

Improved ease-of-use in ADAMS/Vibration, ADAMS/Durability, and
ADAMS/Flex
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Platforms Supported

For MSC.ADAMS 2005 r2, we continue to provide MSC.ADAMS on the latest platforms.
For more information, see the Hardware and Software specifications in the printed
MSC.ADAMS Installation and Operations Guide or available online at:

http://lwww.mscsoftware.com/support/prod_support/adams/

Supported Versions of Integrated Products

Many MSC.ADAMS 2005 r2 products work with other products, such as
ADAMS/Controls with MSC.EASY5. For a table that lists the integrated products and
their compatible versions, see Supported Versions of Integrated Products on page 73.


http://www.mscsoftware.com/support/prod_support/adams/
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New Products
For MSC.ADAMS 2005 r2, we’ve provided the new product:

ADAMS/SmartDriver

ADAMS/SmartDriver is an advanced driver simulator that can bring a vehicle to its
dynamic limits or near targets you define. You must supply a path over which the vehicle
will be driven and a target (either vehicle limits or user-defined limits). The typical
ADAMS/SmartDriver application is for a single mini-maneuver for which you require
maximum or target performance.

ADAMS/SmartDriver lets you improve handling, durability, or ride performance of the
vehicle model based on predicted performance that ADAMS/SmartDriver computes. It
gives you the ability to investigate system-level dynamics of the vehicle model, while
requiring minimal setup.

The Figure 1 summarizes the ADAMS/SmartDriver internal architecture:

Figure 1. ADAMS/SmartDriver Internal Architecture
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ADAMS/SmartDriver calculates the speed profile using a built-in, quasi-static solver.
This solver can take into account tire limits, engine and brake system limits, as well as full
load transfer and aerodynamics.

The internal solver is a fast simplified vehicle model, with rigid suspensions. It inherits all
vehicle data (initial conditions, geometry, inertial values, tires, and so on) from the full
model, and integrates forward in time dynamics, taking into account inertial effects, load
transfer, aerodynamics, and driver demands. Powertrain and tires are fully compliant with
MSC.ADAMS (PAC2002 and PAC96 tire models are fully compliant; PAC94 and PAC89
are supported for compatibility).

Additions to Existing Products

The following are highlights of additions to existing products. For the latest information,
as well as changes, issues resolved, and known issues, go to:

http://lwww.mscsoftware.com/support/prod_support/adams/
ADAMS/Aircraft

New Linear Point Aircraft Aerodynamics Entity

We added a second point aerodynamics entity for use with rigid airframes. This new entity
complements the existing aircraft aerodynamics entity, which you can use to model
nonlinear aerodynamics. This added a new property file in shared database:

AA_zero_aero.Ipt

New Capability to Change Runway Orientation in Landing Simulations

You can now change the orientation of the runway for landing simulations by entering
runway yaw, pitch, and roll values, which are independent of the aircraft yaw, pitch, and
roll orientations. We updated the shared database landing loadcase files from version 1 to
version 2.

landing_drop.llc

landing.llc


http://www.mscsoftware.com/support/prod_support/adams/
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Added Pressure Relief Valve to Equation-Based Damper

Some landing gear shock struts contain pressure relief valves, which are also known as
blow-off valves. The valves serve to limit the maximum pressure that can develop inside
the strut due to high stroke rates. The equation-based, incompressible damper now has an
optional pressure relief valve. Additionally, to improve solver performance, we collapsed
the modeling entity’s internal functions to reduce the number of functions that recursively
reference each other. We updated the shared database equation-based damper file from
version 1 to version 2:

AA_any_damping.eqd

New Simulation Type: Gear Taxi

You can simulate the straight-ahead taxi behavior of a single gear with the new gear taxi
simulation. You can use this if a full aircraft model is unavailable. You can also use this
simulation to focus on the shimmy behavior of a single gear. We added a new directory
and input file to the shared database:

loadcases_geartaxi.tbl/gear_taxi.gtx

ADAMS/Car
=  ADAMS/SmartDriver (new product) support
= Road Builder (ADAMS/3D Road feature) support
= Right turns for open loop and quasi-static cornering events

= Support for abort conditions in the Driving Machine and Event Editor
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ADAMS/Car Ride

Enhanced ADAMS/Vibration Integration

We enhanced ADAMS/Vibration integration by adding support for tire contact patches
actuators (displacement, velocity, acceleration) and wheel center actuators (force) in
ADAMS/Car Ride four-post, test rig frequency analyses. You can define vibration
actuators by swept sine, PSD, or user function.

Enhanced MSC.ADAMS to MSC.Nastran Integration

You can now export MSC.ADAMS models to MSC.Nastran. A direct mapping between
MSC.ADAMS and MSC.Nastran elements is available. Using this option makes it
possible to export models in design condition or after static equilibrium.

ADAMS/Chassis
= Road Builder (ADAMS/3D Road feature) support

= Support for abort conditions in the Driving Machine and Event Editor
ADAMS/Controls

New Controls Plant for Input/Output Signal Visibility

The Controls > Plant Export feature has been modified and repackaged to allow visibility
of the input and output signals specified for the MSC.ADAMS plant. This new Controls
Plant will reside in your model as an assembly, and can be referenced as such. This will
helps bring more clarity when you are working with multiple plant configurations. For
example, once you have created several new plant UDEs, you can quickly locate a given
plant configuration by browsing for it. For ease-of-use, any of your existing Plant_Input
and Plant_Output entities can also be readily accessed to create or modify a new Controls
Plant.

Additionally, we have added support for an initialization command for specifying
non-time advancing commands that you want executed before the co-simulation or
function evaluation starts. For example:

file/command=setup_controls.acf
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For more details on using the new Plant Export dialog box, refer to the guide, Getting
Started Using ADAMS/Controls.

For an example, see Knowledge Base Article 12678:
http://support.adams.com/kb/faq.asp?ID=kb12678.dasp

Usability Improvements for TCP/IP Co-simulation

The 2005 r1 release introduced TCP/IP as a new communication mechanism for
ADAMS/Controls. With 2005 r2, we have made some usability improvements so the
MSC.ADAMS Server now runs as a daemon (adams_daemon.py). This means that it only
needs to be started once, allowing you to send it co-simulation jobs repeatedly. These jobs
can be of either type, interactive or batch (vcontrols and scontrols, respectively), and can
include solver jobs from vertical applications, such as ADAMS/Car.

Example:
adams05r2 python adams_daemon.py exit

Usage:
You can invoke this script in the following ways:
= On UNIX/Linux:
adamsO05r2 -c python topdir/controls/utils/adams_daemon.py [-h] exit
= On Windows:
adamsO05r2 python topdir/controls/utils/adams_daemon.py [-h] [-p port] exit
where:
1 -h prints the help message.
1 -p port specifies the port number. The default value is 30001.

1 topdir is the installation directory of MSC.ADAMS and can be determined
by issuing adams05r2 -top.

When the daemon starts, an informational message appears, notifying you that TCP/IP
mode is ready and operational.


http://support.adams.com/kb/faq.asp?ID=kb12678.dasp
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The ADAMS/Controls server daemon is now operational for TCP/IP communication with
MSC.EASY5 or MATLAB client(s). This server daemon will remain in the send/receive
mode until this window is closed.

For more details on TCP/IP, refer to the ADAMS/Controls online help.

Thin Client Packaging of MSC.ADAMS Server for TCP/IP Co-simulation

The installation files for the MSC.ADAMS server have been packaged separately,
allowing you to install a minimal set of files on the controls application machine (the
machine running MSC.EASY5 or MATLAB), instead of a full MSC.ADAMS installation,
which was required in past releases.

For more details, refer to the MSC.ADAMS Installation and Operations Guide.

For a related example, see Knowledge Base Article 12679:
http://support.adams.com/kb/faq.asp?ID=kb12679.dasp

C++ Solver Support in MSC.EASY5 2005

ADAMS/Solver (C++) is now available as an experimental feature within MSC.EASY5
Solver. This is another step forward in the integration of the two products and allows
MSC.EASYS5 users to seamlessly run their models with ADAMS/Solver (C++) while
staying in the familiar MSC.EASY5 modeling environment. ADAMS/Solver (C++) has
been enhanced with switch-state technology (see the BISECTION and TERROR keywords
on SENSOR) for the handling of discontinuous events prevalent in many MSC.EASY5
models.

For an example, see Knowledge Base Article 12699:
http://support.adams.com/kb/faq.asp?ID=kb12699.dasp


http://support.adams.com/kb/faq.asp?ID=kb12679.dasp
http://support.adams.com/kb/faq.asp?ID=kb12699.dasp
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ADAMS/Durability

Hot Spot Identification

Critical stresses can now be identified more easily from animation contour displays in
ADAMS/PostProcessor. A new Hot Spots tab is available in the Animation dashboard
when the ADAMS/Durability plugin is loaded. This tab allows you to control the
definition, display, and labeling of hot-spot data. You can display hot spots for flexible
bodies that contain stress or strain, or for rigid stress objects (with quasi-static stress
recovery). The hot-spot identification options include:

= Filter (Count, Threshold, Percentage)
= Radius

Caching is used to maintain hot-spot data, so once stress or strain data has been computed
and cached, the control and display of hot spots during animation can be adjusted
interactively (with no delays in processing). The hot-spot graphics can be labeled with
Rank, Value, Frame, and Node ID.

Sort Order of Hot Spots

A Sort Order option has been added to the Hot Spot Information dialog box. This option
is included in the header of the hot spot table. Three settings are available:

= Absolute - Sorts hot spots based on their magnitudes. The Absolute setting is
useful when the value and not the sign is important for selecting hot spots. For
example, in the case of stress, you might consider both compressive (negative)
and tensile (positive) stresses to be equally important.

= Maximum - Sorts hot spots from high to low. The Maximum setting considers
sign and magnitude when sorting hot spots. For example, a value of +100 would
be considered hotter than -200. Until this release, this was the default action for
hot-spot computations.

= Minimum - Sorts hot spots from low to high. The Minimum setting also
considers sign, but sorts the hot spots in reverse order of Maximum. For
example, a value of -100.0 would be considered hotter than a value of 200.
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FEMDATA Improvements
Pinpointing critical stresses is easier with FEMDATA due to the following improvements:

= Annotated FE load file, supplemented with hard-point labels
= Minimum peak loads from FEMDATA

Annotated FE Load File

Additional information on load points, such as MSC.ADAMS marker ID and global
coordinates, is now listed in the FEA Loads Export or FEMDATA loads file.

Minimum Peak Loads from FEMDATA

Both maximum and minimum loads are output with the FEMDATA PEAK_SLICE option
for the FX, FY, FZ, TX, TY, and TZ designations. When a minimum load occurred in the
simulation, the loads are now output to the load file. When the PEAK_SLICE option is
specified on the FEMDATA statement, the maximum peak loads are also output to the load
file.

For example:

FEMDATA/1

, LOADS

, FLEX_BODY =1

,START=0.3

,END=0.4

, FILE = peak

, PEAK_SLICE = FX:FY:FZ:FMAG
OUTPUT/

, LOADS = ANSYS

Then, peak.dat load has new header:

! Load Point Information (Global Reference Frame) :

! Node ID ADAMS ID X Y Z Marker Label
| e e e e e e e e e e e e e e e e e e e e e e e e -
! 0.0000e+000 0.0000e+000 0.0000e+000 MARKER 6
! 1031 24 1.5000e+002 1.0000e+002 0.0000e+000 TAB1

! 1032 25 2.5000e+002 5.0000e+001 0.0000e+000 TAB2

! 1033 26 3.2500e+002 3.0000e+001 0.0000e+000 TAB3

For an example, see Knowledge Base Article 12654:
http://support.adams.com/kb/faq.asp?ID=kb12654.dasp


http://support.adams.com/kb/faq.asp?ID=kb12654.dasp
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Hot-spot Time Range (51657)

Two new optional text boxes have been added to the Hot Spots Information dialog box:
Start and End times. When specified, the computation of hot spots are limited to that time
range. This time range is included in the header of the hot-spot table. Similarly, the
FEMDATA statement also supports time range with START and END arguments, as shown
here:

FEMDATA/1

, STRESS

, FLEX_BODY =5

, START=0.5,END=1.0

, FILE = windowed_stress.tab
, HOTSPOTS =10

, RADIUS =25

, CRITERION = VON_MISES

Pre-Stress and Pre-Strain Support

Modal stress recovery (MSR) in ADAMS/Durability will now take into account pre-stress
and pre-strain in flexible bodies. A block to store the stress and/or strain state due to a
preload has been added to the MNF. MSC.Nastran 2006 will support the output of these
blocks when a preload is included and stress (or strain) is requested.

For an example, see Knowledge Base Article 12655:
http://support.adams.com/kb/fag.asp?ID=kb12655.dasp

XDB Support for MSC.Fatigue Export

A new XDB option has been added to the MSC.Fatigue Export dialog box. With this
option, you can import the modal data from an XDB file instead of an OP2. Unlike an OP2
file, XDB does not have any file size limitations and uses less memory when importing
data.


http://support.adams.com/kb/faq.asp?ID=kb12655.dasp
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ADAMS/Engine—powered by FEV

ADAMS/Solver (C++) Supports ADAMS/Linear and ADAMS/Vibration

You can now use ADAMS/Solver (C++), which is the default solver in ADAMS/Engine,
to run eigen value solutions by selecting Perform Linear Analysis in analysis dialog boxes.
You can now also run ADAMS/Vibration with ADAMS/Solver (C++). In particular, this
means that 2D chains and belts can now be used for eigenvalue solutions and vibration
studies.

For more details, see the Release Notes for ADAMS/Solver on page 41 and ADAMS/Linear
on page 33.

Modal Force Hydrodynamic Bearing

A new bearing component has been added to ADAMS/Engine Advanced Cranktrain to
improve the analysis of hydrodynamic bearings. The modal force hydrodynamic bearing
is only supported with ADAMS/Solver (C++).

Utility to Generate MSC.Nastran Input File

You can now automatically write the MSC.Nastran input file needed to generate the .mnf
file of a crankshaft or engine block from within ADAMS/Engine.

Torsional Vibration Train

You can now perform a linear torsional vibration analysis of a dynamically loaded
cranktrain system through the Haffner-Maass method from within ADAMS/Engine.

ADAMS/Flex

Generalized Modal Damping (C++ Solver Only)

You can now obtain the generalized damping matrix from MSC.Nastran and apply it to a
flexible body. This is another step forward in our MSC.Nastran-MSC.ADAMS integration
efforts and will help improve life prediction estimates and correlation with finite element
analyses.

Like the generalized mass and stiffness matrix, the MNF will contain a generalized
damping matrix if any form of damping is defined in the MSC.Nastran data deck. The
generalized damping matrix can optionally be applied to the flexible body in
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MSC.ADAMS. Furthermore, you can choose whether to include damping effects on the
FLEX_BODY rigid body degrees of freedom. Generalized damping and modal damping
are not mutually exclusive. That is, their effects are additive.

For an example, see Knowledge Base Article 12660:
http://support.adams.com/kb/fag.asp?ID=kb12660.dasp

ADAMS Dataset Language
To apply the generalized damping to a flexible body, add the gdamp option to the
FLEX_BODY statement, for example:

FLEX_BODY/1, MATRICES =1, 2, 3,4,5,6, 7, 8,9, 10, 11, 12, 13
, CRATIO = 0.0/ GDAMP=FULL, MNF_FILE = my.mnf

You can also instruct MSC.ADAMS to ignore damping forces on the rigid body degrees
of freedom by specifying GDAMP=INTERNAL_ONLY:

FLEX_BODY/1, MATRICES =1, 2,3,4,5,6,7,8,9, 10, 11, 12, 13
, CRATIO = 0.0/ GDAMP=INTERNAL_ONLY, MNF_FILE = my.mnf

Access in ADAMS/View

Generalized modal damping can be accessed in the Flexible Body Modify and Create a
Flexible Body dialog boxes.

State-dependent Modal Force (MFORCE)

Target applications, such as sophisticated damping models, crosswind vehicle loading,
and other aerodynamics loading, will benefit from our new state-dependent modal force.
We now support independent scaling of each load vector by a state-dependent factor. We
have observed some significant performance improvements in some engine applications
where 300 independent MFORCESs were replaced by a single state-dependent modal force.

For an example, see Knowledge Base Article 12659:
http://support.adams.com/kb/fag.asp?ID=kb12659.dasp


http://support.adams.com/kb/faq.asp?ID=kb12660.dasp
http://support.adams.com/kb/faq.asp?ID=kb12659.dasp
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Introduction
Before MSC.ADAMS 2005 r2, the most general construct of the MFORCE was:

mf(q,t) = s(qg,t) *[g_1(t) *f 1+ ...+ g_n(t) *f_n] 1)
where:

= mf(g,t) - 6 + m vector dependent on solver state and time
= 5(q,t) - Scalar function dependent on solver state and time
= g_i(t) - Scalar function dependent only on time
= f i-6+ m constant load vector
= m - Number of active modes in the flexible body
= n - Number of superimposed load vectors

Most users will only consider a single load case per MFORCE, (that is, n = 1), in which
case, (1) reduces to:

mf(q,t) = s(q,t) *f_i (2)
The user defines an MFORCE given by (2) by specifying the load case i and scale factor
s(q,t). Both the MSC.ADAMS dataset language and the ADAMS/View command

language facilitate this type of definition. Users interested in defining the more general
MFORCE given by (1) are required to use the MFOSUB user-written subroutine interface.

Note that (1) does not allow individual load cases or components of the load vectors to be
independently scaled by functions of solver state. This restriction allows a very efficient
implementation of the MFORCE, and for most applications it is not limiting. Users
interested in scaling each load vector by a function of state could work around the
restriction by creating multiple MFORCEs. For example:

mf(qg,t) = mf_1(q,t) + mf_2(q,t) + ... + mf_n(q,t) 3)
where:

m  mf_i(g,t) =s_i(g,t) *f_i
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In ADAMS/Solver (C++) 2005 r2, the MFORCE supports the very general form:

mf(q,t) = f(q,t) (4)
where;

= f(g,t) = 6 + m vector with each component varying independently on solver state
and time.

This more general form facilitates applications in aeroelasticity, material damping, and
vehicle cross-wing loading. You can only specify an MFORCE of form (4) using an
MFOSUB. It is important to note that generality comes at a price. Solving an MFORCE of
type (4) is more expensive than (1). Because most users will not require this general form
and because it is more expensive to solve, the old form (1) is still supported and should be
used if it satisfies the application.

ADAMS Dataset Language
In the ADM file, you would define a traditional MFORCE of type (1) as follows:
MFORCE/id, FLEX_BODY = id, [JFLOAT =id]

,FUNCTION = USER(r1, [r2, ... r30]
,[ROUTINE = libname::subname]

In this case, an MFOSUB is required and returns the scale function s(q,t) and the
summation of load vectors:

g 1 *f1+...+g_nit)*fn
In MSC.ADAMS 2005 r2, an MFORCE of type (4) is similarly defined as:

MFORCE/id, FLEX BODY = id, [JFLOAT = id]
,FORCE = USER(r1, [r2, ... r30], [NOSCALE]
,[ROUTINE = libname::subname]

The only difference is that FUNCTION = USER(...) has been replaced with FORCE =
USER(...).
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User-written Interface
The same MFOSUB interface is used for MFORCEs of type (1) and (4):

SUBROUTINE MFOSUB(ID, TIME, PAR, NPAR, DFLAG, IFLAG,
+ MODLOADS, NMODES, NCASES, SCALE,
+ CASE, LOADVEC)

For type (4), the user returns the modal force function f(q,t) in the LOADVEC array. If the
user tries to modify CASE or SCALE, a warning is issued.

Accessing in ADAMS/View

To build an MFORCE in ADAMS/View, select the Distributed Load tool from the
Connector palette. In the Create Modal Force dialog box, create an MFORCE of type (1)
by selecting Subroutine in the Define Using pull-down menu. An MFORCE of type (4) is
created by selecting Force in the Define Using pull-down menu.

MNF Generated from Experimental Data

Capability of creating an MNF from experimental data is now available. A utility has been
developed that creates a constant-coupling MNF from experimental measurements on a
component. Required measurements include:

= Global mass/inertia properties
= Natural frequencies
= Deformations at attachment points

We accept Universal files generated from I-DEAS Test and others. A new MNF translator
utility is accessible from the MDI script. For example:

adams -c flextk unv2mnf myfile.unv [option1] [option2] [option3] ....
The utility and options are similar to mnf2mtx.exe.

For an example, see Knowledge Base Article 12661.:
http://support.adams.com/kb/faq.asp?ID=kb12661.dasp


http://support.adams.com/kb/faq.asp?ID=kb12661.dasp
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Point-to-Plane and Curve-to-Plane Contact Support For Flexible Bodies

By supporting points on flexible bodies in MSC.ADAMS 2005 r2, you can now enforce
simple point-to-plane and point-to-curve contact conditions on flexible bodies. The point
can exist on the flexible body, but the plane or curve cannot. ADAMS/Solver (C++)
supports several points defined in a single contact; ADAMS/Solver (FORTRAN) only
supports a single point per contact.

For an example, see Knowledge Base Article 12658:

http://support.adams.com/kb/fag.asp?ID=kb12658.dasp

On-demand Purge of Animation Flexible-body Cache Files

In response to user request, we have added features for clearing flexible-body cache files
in the working directory. You can use the file cache purge command and or menu buttons
on the Tools menu in ADAMS/View and ADAMS/PostProcessor:

Tools - Purge Cache Files

MNF Generation Available in MSC.Nastran SOL 600

You can now create modal neutral files (MNF) directly in SOL 600 when using
MSC.Nastran 2006.


http://support.adams.com/kb/faq.asp?ID=kb12658.dasp
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ADAMS/Insight

Improved Factor Form

The form for setting Factor attributes has been modified to include tabs for the various
attributes. There are four tabs: Settings, Variation, Tie, and Description. The Settings tab
is used to specify the factor type (discrete or continuous), delta type, settings, and
tolerance. There is also a new option called Settings Details that provides information on
the lower limit, nominal, and upper limit for the settings.

A new Variation tab is used for specifying variation information for Monte Carlo and
Latin Hypercube investigations. In addition to Normal and Uniform, the supported
distributions now include Lognormal, Weibull, Discrete, and user supplied. A small
graphic displays an example of the distribution type. Additional information on the current
settings of the selected distribution is available by selecting Variation Details. You can
specify Coefficient of Variation, Percent, or Tolerance and ADAMS/Insight will
automatically compute the standard deviation, one of the required inputs for the
distribution. Similarly, you can specify the cutoff limits in terms of Number of Standard
Deviations, Percent, or Absolute Value of limits.

Enhanced Response Form

The response form has a new tab for specifying optimization information. At the time of
response selection, you have the option of specifying optimization criteria, such as target
value, optimization weight, and the objective (for example, greater than, less than, and so
on).

Enhanced Design Specification Form

The Design Specification form now has a new Modified Latin Hypercube option available
under the Investigation Strategies. This provides an alternative to the Monte Carlo
sampling technique for variation studies.

Improved Workspace Correlation

Performance enhancements have been made for the computation of correlation values.
Both Pearson and Spearman Rank correlations are computed. Various filters can be
applied to the correlation matrix to simplify the view.
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Enhanced Optimization Form

There is a new option that saves the current factor and response settings as defaults.
ADAMS/Insight uses the default settings to fill in the Optimization Form when you
display it. If you make changes to the settings and close the Optimization Form without
saving them, they will be lost.

In addition, a new optimization solver called Stochastic Design Improvement (SDI) is now
available. SDI is a stochastic solver. At each step (iteration), SDI randomly generates a set
of trials around the current design point. It then selects the best trial, generates a new set
of trials around that point, and continues.

Conduit Enhancements

New conduits that allow ADAMS/Insight to be used with MSC.Patran and MSC.Robust
Design are now available. These options are accessed through Simulation > Add Simulation.

Using the MSC.Patran option, you can specify an MSC.Patran session file or a parametric
output file that ADAMS/Insight will read and interpret. You can then build the experiment
with the various factors and responses.

Using the MSC.Robust Design option, you can specify an MSC.Robust Design
experiment (.xml file). ADAMS/Insight will then read and interpret the file, including
results. You can then use ADAMS/Insight’s postprocessing capabilities to explore the
experiment results.

New Direct Optimization

ADAMS/Insight now supports direct optimization with MSC.EASY5 and MSC.Patran
models, in addition to optimization using the response-surface-based surrogate model.
You can access the direct optimization capability using Simulation > Run - Direct. This
option can also be used to invoke a single run of the associated solver through the
ADAMS/Insight interface. Direct optimization is also available with the ASCII conduit.

Usability Enhancements
This release also includes several usability enhancements, such as:

= Updated customization examples

= Extended command-line arguments
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ADAMS/Linear
ADAMS/Linear has been enhanced in the following ways:
= ADAMS/Solver (C++) now supports the Linear command.

= Exact linearization is supported for time-dependent systems
(ADAMS/Solver (C++) only).

= Linear models can be generated with user-specified states
(ADAMS/Solver (C++) only).

= Automated specification of user-defined states (ADAMS/Solver (C++) only).

= Calculation and export of [M], [K], and [B] matrices (ADAMS/Solver (C++)
only).

ADAMS/Solver (C++) now Supports ADAMS/Linear
ADAMS/Linear is now fully supported by the ADAMS/Solver (C++). You can use the
existing features of ADAMS/Linear, such as:

= Eigenvalue solution

= Modal energy calculation

= State matrix generation

Any MSC.ADAMS model that was linearized using ADAMS/Solver (FORTRAN) can
now be linearized using ADAMS/Solver (C++).

ADAMS/Solver (C++) doesn’t have an .out file; you may need to look closely to recognize
that the energy tables are written to a separate external file, as noted at the bottom of the
eigenvalue output:

EIGENVALUES at time = 0.00000E+00
Number Real (cycles/unit time) Imag. (cycles/unit time)

1 0.00000E+00 +/- 7.42040E-01
Energy tables calculations were written to file your model.txt.
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Exact Linearization is Supported for Time-dependent Systems (ADAMS/Solver
(C++) only)

ADAMS/Linear has been enhanced so an exact linearization is now obtained for
time-dependent and non-stationary systems. This enhancement directly leads to key
benefits. ADAMS/Linear accurately captures the dependency of:

= Eigenvalues on angular velocity for rotating systems
= State matrices on system velocities

No simplifications of the equations of motion are made and all rotational effects (that is,
gyroscopic effects, coriolis effects, and explicit time dependencies) are taken into
consideration. The linearization can be done at any valid operating point:

= After assembly (IC solution)
= Static equilibrium

= Dynamic operating points

Linear Models Can Be Generated With User-specified States (ADAMS/Solver
(C++) only)

ADAMS/Linear requires a minimum representation of the system to generate the state
matrix from which eigenvalues can be computed. For non-stationary systems, the state
matrix is a function of the states used to linearize the system.

In previous versions of ADAMS/Linear, the minimum representation of the system was
automatically found; you were not given any control over the specification of coordinates
used to represent the system.

A new modeling object, PSTATE, has been created that allows you to define a set of states
that are to be used in the linearization scheme. You can specify as many states as there are
degrees of freedom. If a smaller set of states are provided, then the system will fill in, by
choosing a set of internally available states for the ones that were not explicitly specified.
If too many states are specified, ADAMS/Solver identifies and discards the redundant
states.

PSTATEs are a list of VARIABLES. The VARIABLES contain expressions that specify the
states that are to be used in linearizing the system. PSTATE objects are defined in the
model (ADM) file. The LINEAR command (in the ACF) can instruct ADAMS/Solver to
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use a specific PSTATE object for generating the linear model. A model file (ADM) can
contain any number of PSTATE objects. You can use any one of them with the LINEAR
command.

Below are some sample commands using PSTATE:

ADM File:

VARIABLE/1001, FUNCTION=AZ(21,11)

VARIABLE/1002, FUNCTION=AZ(31,22)

VARIABLE/1003, FUNCTION=AZ(41,32)

VARIABLE/1004, FUNCTION=DZ(51,42,42)

VARIABLE/2001, FUNCTION=AZ(21,11) + AZ(31,22)

VARIABLE/2002, FUNCTION=AZ(31,22) + AZ(41,32)

VARIABLE/2003, FUNCTION=AZ(41,32) + AZ(21,11)

VARIABLE/2004, FUNCTION=SQRT(DX(51,42,42)**2+DY(51,42,42)**2+DZ(51,42,42)**2)
PSTATE/1, VAR = 1001, 1002, 1003

PSTATE/2, VAR = 2001, 2002, 2003

ACF File:

SIM/INI

LIN/EIG, PSTATE=2

LINEAR/STATEMAT, PSTATE=1, FORMAT=matrixx, FILE=m1.dat
LINEAR/STATEMAT, PSTATE=2, FORMAT=matrixx, FILE=m2.dat

The states used by ADAMS/Solver are reported in the message file. For example:

EigenSolution computation started.
Option RM was not used.
This model has
26 kinematic states (displacement and velocities)
0 differential states ( DIFFs, LSEs, etc.)
The selected kinematic states are:

1 PSTATE VARIABLE VAR/1 DX (20,23,23)
2 PSTATE VARIABLE VAR/2 DY (20,23,23)
3 PSTATE VARIABLE VAR/3 DZ(20,23,23)
4 PSTATE VARIABLE VAR/4 AX(20,23)
5 PSTATE VARIABLE VAR/5 AY (20,23)
6 PSTATE VARIABLE VAR/6 AZ(20,23)
7 PSTATE VARIABLE VAR/7 DX (21,23,23)
8 PSTATE VARIABLE VAR/8 DY (21,23,23)

9 PSTATE VARIABLE VAR/9 Dz (21,23,23)
10 PSTATE VARIABLE VAR/10 AX(21,23)
11 PSTATE VARIABLE VAR/11 AY (21,23)
12 PSTATE VARIABLE VAR/12 AZ(21,23)
13 PSTATE VARIABLE VAR/13 AZ(22,23)



MSC.ADAMS Release Guide
36 What's New

For more information, see the ADAMS/Solver (C++) LINEAR command.

For theoretical details, see the white paper in Knowledge Base Article 12721
http://support.adams.com/kb/fag.asp?ID=kb12721.dasp

For an example of using PSTATE, see Knowledge Base Article 12663:
http://support.adams.com/kb/fag.asp?ID=kb12663.dasp

Automated Specification of User-defined States (ADAMS/Solver (C++) only)
The identification of independent states can be quite tedious for large models.

ADAMS/Solver (C++) offers an option to select relative coordinates for generating state
matrices.

The LINEAR command now supports a new RM keyword. RM accepts a Marker ID as
input. RM essentially serves as the reference frame for the observer of the system. The
translational and rotational displacements of all bodies in the system are calculated relative
to the RM marker and in the RM coordinate system (where applicable).

The following are examples of using RM:

ADM File:
MARKER/13, PART=3, QP=1,2,3, REU=0D,90D, 180D

ACF File:

SIM/DYN, END=1.5, STEPS=150
LIN/EIG, RM=13
LINEAR/STATEMAT, RM=13, FILE=local_RM_statM.txt

You can also use a combination or RM and PSTATE for even more flexibility. In such a
situation, the states specified by PSTATE are given higher priority that the states specified
by RM.


http://support.adams.com/kb/faq.asp?ID=kb12670.dasp
http://support.adams.com/kb/faq.asp?ID=kb12670.dasp
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The following example uses both RM and PSTATE:

ADM File:

MARKER/13, PART=3, QP=1,2,3, REU=0D,90D, 180D
VARIABLE/2001, FUNCTION=AZ(21,11) + AZ(31,22)

VARIABLE/2002, FUNCTION=AZ(31,22) + AZ(41,32)

VARIABLE/2003, FUNCTION=AZ(41,32) + AZ(21,11)

VARIABLE/2004, FUNCTION=SQRT(DX(51,42,42)**2+DY(51,42,42)**2+DZ(51,42,42)**2)
PSTATE/2, VAR = 2001, 2002, 2003

ACF File:

SIM/INI
LINEAR/STATEMAT, RM=13, PSTATE=2, FILE=local_RM_statM.txt
LIN/EIG, ENERGY=1,2, DISS=1,2, KINETIC=1,2, STRAIN=1,2, PSTATE=2

Sample for energy tables:

SIM/INI
LIN/EIG, ENERGY=1,2, DISS=1,2, KINETIC=1,2, STRAIN=1,2, PSTATE=1

The states used by ADAMS/Solver are reported in the message file. For example:

EigenSolution computation started.
Option RM=23 was used.
This model has
26 kinematic states (displacement and velocities)
0 differential states ( DIFFs, LSEs, etc.)
The selected kinematic states are:

1 Relative displacement DX (GROUND, 23,23) PART/2
Relative displacement DY (GROUND, 23,23) PART/2
Relative displacement DZ(GROUND, 23,23) PART/2
Relative rotation AX (GROUND, 23) PART/2
Relative rotation AY (GROUND, 23) PART/2
Relative rotation AZ (GROUND, 23) PART/2
Relative rotation AZ(BCS,23) PART/3
Relative displacement DX (BCS,23,23) PART/4

9 Relative displacement DY (BCS,23,23) PART/4
10 Relative displacement DZ(BCS,23,23) PART/4
11 Relative rotation AX (BCS,23) PART/4
12 Relative rotation AY (BCS,23) PART/4
13 Relative rotation AZ(BCS,23) PART/4

w0 J o0 U WN

For more information, see the ADAMS/Solver (C++) LINEAR command.
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For theoretical details, see the white paper in Knowledge Base Article 12721
http://support.adams.com/kb/faq.asp?ID=kb12721.dasp

For an example of using RM, see Knowledge Base Article 12690:
http://support.adams.com/kb/fag.asp?ID=kb12690.dasp

Calculation and Export of [M], [K], and [B] Matrices (ADAMS/Solver (C++) only)

The mass [M], stiffness [K], and damping matrices [B] matrices can now be exported from
ADAMS/Linear. This is useful when you want to take the system matrices from
MSC.ADAMS to a finite element (FE) package, such as MSC.Nastran, for further
analysis.

Below is an example of how to generate [M], [K], and [B] matrices from ADAMS/Linear:

ACF File:

PREFERENCES/SOLVER=CXX
SIM/STA
LINEAR/MKB, FORMAT=matlab, FILE=mkb_mat, PSTATE=5, PINPUT=1, POUTPUT=1

The above command produces the following list of state matrix files:

mkb_matb
mkb_matc
mkb_matd
mkb_matk
mkb_matm
mkb_matpi
mkb_matpo
mkb_matst


http://support.adams.com/kb/faq.asp?ID=kb12721.dasp
http://support.adams.com/kb/faq.asp?ID=kb12690.dasp
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ADAMS/View Interface
You can create the PSTATE and RM objects in ADAMS/View in several ways:

= Use Build > Controls Toolkit > Plant State to create a plant state.

m  Access existing PSTATE objects and/or select RM through the Simulation
Control dialog box in ADAMS/View.

m  Create/access PSTATE and select RM through the ACF builder interface.
= Access to PSTATE and RM is also available in ADAMS/Vibration through the
Test - Vibration Analysis dialog box.
ADAMS/PostProcessor
See the release notes for ADAMS/View on page 51.

ADAMS/Rail

Curve Manager Enhancements

Curve Manager now supports a new format for the track property file (TRK_4). A toolkit
for the conversion of old property files is also available. You can use the same conversion
tool to convert the old irregularities format (*.dat files) to the new irregularities TOF
format (*.idf file). Old property files are still compatible with ADAMS/Rail Solver.

Curve Manager now supports property files for rail profiles (RPR).

Profiles are now displayed using the same interpolation function used in the simulation,
allowing you to see possible problems in the profile description at design time.

We enhanced analytic track visualization to support track with U-turns.

Curve Manager plots for wheel and rail profiles have the same scale for lateral and vertical
coordinates so that the profile is shown with its actual shape.

We added visualization of track irregularities (analytic, measure, PSD).
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Improved Track Measured Irregularities Description

We added a new format for measured irregularities, allowing you to specify lateral and
vertical perturbation of the centerline, as well as a value for banking perturbation.

You can specify an additional column containing the abscissae for all available formats. If
you specify this column, the abscissa is calculated using the user-input data rather than the
fixed step.

Improved Analytic Track Description

You can now specify consequent curve segments. ADAMS/Rail uses clothoid curves for
the transition between the two sections.

Property Files Unit Independence
All ADAMS/Rail-specific property files now support unit independence:

= Track property file (*.trk)

= Wheel property files (*.wpf)

= Contact configuration file (*.ccf)

= Wheel and rail profile property files (*.wpr and *.rpr)

= Rail and guiding rail flexibility configuration files (*.frp and *.grp)

Improved RSGEO

We removed the limitation to the number of rows of the contact table in RSGEO. The
contact table is now dynamically allocated, and table size is only limited by your
computer’s capabilities.

Stability Map
It is now possible to create a Stability Map Plot starting from a previously created .stb file,
without re-running the stability analysis.
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ADAMS/Solver

Enhanced SMP Capabilities

ADAMS/Solver (C++) 2005 r2 can now apply Symmetric Multi-Processing (SMP) (also
known as Shared-Memory Parallelism) during the evaluation of nearly all the elements in
the MSC.ADAMS element library. Parallel processing is enabled in ADAMS/Solver
(C++) by setting the statement PREFERENCES/NTHREADS (number of threads
accordingly).

The most significant enhancement to parallel-processing capabilities for version 2005 r2
is that ADAMS/Solver (C++) is now capable of evaluating 3D solid-to-solid
(Default_library only) and 2D contact elements in parallel.

Notable exceptions from the parallel evaluation are:

= 3D solid-to-solid based on the Parasolid geometry engine are not evaluated in
parallel. ADAMS/Solver (C++) is only capable of evaluating 3D solid-to-solid
contacts in parallel when the default Rapid geometry engine is used. To identify
whether you are currently using the Parasolid geometry engine, look for the
following statement in your .adm file:

PREFERENCES/CONTACT_GEOMETRY_LIBRARY=Parasolid

= The General State Equation (GSE) element is not yet evaluated in parallel.

= Elements based on user-written subroutines (for example, GFOSUB or
VARSUB) are not evaluated in parallel unless you declare the user subroutine
thread-safe by calling the utility subroutine ADAMS_DECLARE_THREADSAFE.
A user subroutine is thread-safe when two threads can be executing the
subroutine concurrently when the value of IFLAG is zero or false.

ADAMS/Solver (C++) carefully excludes elements from these categories from parallel
evaluation and evaluates them serially after evaluating other elements in parallel.

For an example, see Knowledge Base Article 12664:
http://support.adams.com/kb/faq.asp?ID=kb12664.dasp


http://support.adams.com/kb/faq.asp?ID=kb12664.dasp
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SAVE and RELOAD Command Support

The SAVE/SYSTEM command stores the current ADAMS/Solver (C++) model and
simulation conditions. This restart file allows you to return to the model at a later time
using the RELOAD/SYSTEM command to continue where you left off. This feature is
particularly useful when debugging complex models. For example, you could save a static
equilibrium solution that was difficult to get to run and reload it later as a starting point for
dynamic analyses. Similarly, if you have a problematic model, the save operation can be
used to capture the model before difficult events, and then you can reload the model as you
experiment with different solution strategies.

Sample Usage:

In the example in Figure 2, reload.acf shows ADAMS/Solver (C++)’s ability to start with
an empty line, followed by the reload. In other words, there is no need to have access to
the .adm for the reload operation.

Figure 2. Example of save.acf and reload.acfl

/ save.acf reload.acf \

model 1.adm <tkiz lime shonld be =mply or blank>
model 1 PREF/ SOLVER=CXX
FEREF/ 30LUER=CXX RELORD/EYE, FILE==static. sau, OUTPUT=dymamic
EQT/MAY IT=50, 3TAE=_1,TLIM=1.0 INTE/HHNT , ERR=1a-5 ~
SIMY STATIC SIM/DYWAMIC ,END=0_1,3TEP3=£5
SBVE/SYETEH, FILE=static.saw ZIM/DYNAMIC ,END=0.% , BTEPE=E5
STOF 4 STOF
Here SAVE is used to save the Here RELOAD is used to restore
model in the static configuration, the static configuration before
far reuse in subsequent proceeding with dynamic analyses.
analyses.

Note that save.acf could have had multiple save-points, which could then be reloaded with
other ACF files.
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Note: ADAMS/Solver (C++) has been modified so that when it sees a SAVE/STATES
command, it issues the following warning and continues:

STATES option in SAVE command is not supported. SYSTEM will be saved.

For an example, see Knowledge Base Article 12665:
http://support.adams.com/kb/fag.asp?ID=kb12665.dasp

Compliance Matrix Support (GTCMAT)

The GTCMAT utility subroutine is now supported in ADAMS/Solver (C++). This allows
you to compute the compliance matrix for a set of markers in an ADAMS/Solver model.
The GTCMAT has been enhanced so you are no longer restricted to performing a static or
quasi-static simulation first; you can now compute compliance after a dynamic simulation.
This feature is unique to ADAMS/Solver (C++) and it may be helpful to vehicle dynamics
engineers who have traditionally looked only at compliance for the static configuration
and have wondered how compliance can change during dynamic events.

For an example, see Knowledge Base Article 12689:
http://support.adams.com/kb/faq.asp?ID=kb12689.dasp

Support for ADAMS/Linear

ADAMS/Linear is now fully integrated with ADAMS/Solver (C++). You can use existing
features of ADAMS/Linear, such as eigenvalue solution, modal energy calculation, and
state matrix generation.

Also, capabilities have been enhanced so you can now find the correct eigenvalues for
rotating systems. You can achieve this through new RM and/or PSTATE features. For more
details, see the release notes for ADAMS/Linear on page 33.

For an example, see Knowledge Base Article 12663:
http://support.adams.com/kb/faq.asp?ID=kb12663.dasp


http://support.adams.com/kb/faq.asp?ID=kb12665.dasp
http://support.adams.com/kb/faq.asp?ID=kb12689.dasp
http://support.adams.com/kb/faq.asp?ID=kb12663.dasp
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Support for ADAMS/Vibration

Vibration simulations can now be solved with ADAMS/Solver (C++). New features
introduced in ADAMS/Linear are also available, including PSTATE and RM for rotating
systems and [M][K][B] export for obtaining the mass, stiffness, and damping matrices.

For more information, see the release notes for ADAMS/Vibration on page 47.

For an example, see Knowledge Base Article 12670:
http://support.adams.com/kb/fag.asp?ID=kb12670.dasp

ADAMS/Solver (C++) Support in MSC.EASY5 2005

ADAMS/Solver (C++) is now available as an experimental feature within MSC.EASY5
Solver. This is another step in the integration of the two products and allows MSC.EASY5
users to seamlessly run their models with ADAMS/Solver (C++) while staying within the
familiar MSC.EASY5 modeling environment. ADAMS/Solver (C++) has been enhanced
with switch-state technology for the handling of discontinuous events prevalent in many
MSC.EASY5 models.

For an example, see Knowledge Base Article 12699:
http://support.adams.com/kb/fag.asp?ID=kb12699.dasp

NFORCE Support
The NFORCE multi-point force element is now supported by ADAMS/Solver (C++).

If you have legacy models containing NFORCESs for general flexibility, you can now run
them with ADAMS/Solver (C++), which enables you to take advantage of a growing
number of features unique to C++. Unlike ADAMS/Solver (FORTRAN), the NFORCE
measure can appear in any function expression in the ADAMS/Solver (C++) dataset.

For an example, see Knowledge Base Article 12662:
http://support.adams.com/kb/faq.asp?ID=kb12662.dasp


http://support.adams.com/kb/faq.asp?ID=kb12670.dasp
http://support.adams.com/kb/faq.asp?ID=kb12662.dasp
http://support.adams.com/kb/faq.asp?ID=kb12699.dasp
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MARKER Command Enhancement (C++ Solver only)

The RM argument on the MARKER command can now be a marker on any part in the
model, instead of being restricted to the parent body only. This modeling feature becomes
particularly useful when, for example, you want to make a joint’s J-marker coincident with
its I-marker before activating the joint.

MARKER/8, QP=0,0,0, REULER=0d,0d,0d, RM=7 | ---move J-marker of JOINT/2
ACTIVATE/JOINT, ID=2 | ---enable joint

Note that marker reorientation occurs on-the-fly in ADAMS/Solver (C++) during
run-time, and as such, the orientation change does not persist into the modeling position
of ADAMS/View. In other words, use ADAMS/View if you want to change the modeling
positions and orientations of markers during design-time.

For an example, see Knowledge Base Article 12681.:
http://support.adams.com/kb/faq.asp?ID=kb12681.dasp

ADAMS/Tire

3D: Interface to Generate 3D Road

A Road Builder interface has been introduced in ADAMS/Car and ADAMS/Chassis to
create and edit XML 3D Road definition files. The features of the Road Builder include:

= TeimOrbit 3D road definition files automatically translated to XML format
= Create, edit, and visualize the 3D Road data points table
m Create and edit 3D Road obstacles

Using XML 3D Road Definition files, the 3D Road obstacles, which are independent of
the traveled distance of the vehicle, can now be visualized in ADAMS/Car and
ADAMS/View.

Note: You can still use TeimOrbit 3D Road Definition files.


http://support.adams.com/kb/faq.asp?ID=kb12681.dasp
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Pacejka '94 and '89: Mirroring in Pacejka '94 and '89 Tire Models

Similar to the mirroring functionality in PAC2002, you can now mirror the tire lateral
force and aligning moment response to use the tire on the other side of the vehicle, then
for which the parameters have been measured. You introduce mirroring in the [MODEL]
section of the tire property file:

TYRESIDE ='LEFT' /'RIGHT'/'SYMMETRIC'

All Handling Tires: Implement the Option to Use Nonlinear Vertical Stiffness

Spline functionality was introduced for PAC2002, PAC_MC, and all other handling tire
models in ADAMS/Tire 2005 r2. Instead of the current linear vertical stiffness, you can
define tire deflection-load spline data in the [DEFLECTION_LOAD_CURVE] section, which
then is used for the vertical tire load response. See the example tire property files in
ADAMS/Tire online help.

PAC2002: More Advanced Tire Transient Behavior and Standstill in PAC2002
An advanced transient tire model, the contact-mass model, has been added to PAC2002:

= Longitudinal and lateral tire carcass stiffness
= Slip dependent relaxation effect
= Transient response to friction changes

= Improved low-speed tire damping

PAC2002: Enhancements for PAC2002

In addition to the advanced tire transient behavior, following items have been introduced
in the PAC2002 tire model:

= Advanced modeling for loaded radius and rolling radius modeling, important for
roll over and racing applications.

= Tire bottoming, for example, to simulate the rim hitting the road.

= Online scaling factors—the PAC2002 scaling factors can be changed during the
simulation. This can also be applied in a MATLAB co-simulation analysis.

= Switch for linear quasi-statics calculations at the start of the simulation for
avoiding statics problems with very (longitudinal) stiff tires.
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PAC_MC: Updated Contact Model for ADAMS/Tire Motorcycle Tire

The PAC_MC tire model, a Pacejka handling tire model for motorcycle tires, was
extended with a more advanced method for calculating the contact point between the tire
and the road.

Because the inclination between the wheel and road plane can run up to considerable
values (60 degrees), the cross-section shape of the tire plays an important role. The contact
calculations were updated to include the tire cross section.

PAC-TIME: New PAC-TIME Tire Model in ADAMS/Tire Handling

A new Pacejka type tire model for handling has been introduced. The model is close to
PAC2002, however, it uses different modeling for Fy and Mz according to the European
Research project TIME, focusing on measuring tire properties during realistic tire
operation conditions.

ADAMS/Vibration

New Vibration Build-Test-Review-Improve Menu Structure

A Vibration menu has been added to the ADAMS/Vibration plugin with all new and
preexisting features of ADAMS/Vibration now organized into Build, Test, Review, and
Improve menus. This change is meant to reinforce the paradigm for building successful
models, to improve ease-of-use, and to shorten the learning curve for new and occasional
users. For an example, see Knowledge Base Article 12667:

http://support.adams.com/kb/faq.asp?ID=kb12667.dasp


http://support.adams.com/kb/faq.asp?ID=kb12667.dasp
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Eigenvalue and Energy Table Highlighting

To assist you in identifying potential NVH trouble spots in your model and/or designs, we
have enhanced the tabular output tables to better identify key values. Bold fonts and
highlighting are now used to draw your attention to values of interest in the following
tables:

= Eigenvalue - Unstable modes are now highlighted and the Real component is
displayed in bold font, since that is the key identifier of an unstable mode. A
threshold value can be set so you have some control over the highlighting of
small (insignificant) values. Another useful feature added to the Eigen Table is
+/- buttons which allow you to quickly step through a series of eigenvalue tables
when you have several analyses to review. To access this table, use Vibration >
Review - Display Eigenvalue Table.

= Modal energy - The name(s) of maximum energy objects are now highlighted,
for a given mode, and for the row that contains the maximum energy object, we
use bold font for the cell containing the highest component of energy on that
row.

= Modal participation - Maximum values, for a given frequency, are now
highlighted and displayed in bold font.
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Spec-line Navigation in Forced Vibration Animations

Navigating between peaks of an FRF plot and the associated frequency in a forced
vibration animation is simplified with the ability to add spec lines using new keyboard
shortcuts. ADAMS/PostProcessor already has functionality in plot statistics (tracking)
mode to navigate from one local maximum/minimum to the next. Using Shift+left/right
arrow moves you from one local maximum to the next. Using Ctrl+left/right arrow moves
you from one local minimum to the next. Now, making a spec line is done easily, as
follows:

= sand S create vertical spec lines.
= hand H create horizontal spec lines.

Navigating to the associated frequency in a forced vibration animation is also made easier
by allowing you to browse for a spec line in the Frequency text box in the Vibration
animation dashboard in ADAMS/PostProcessor. For an example, see Knowledge Base
Article 12669:

http://support.adams.com/kb/faq.asp?ID=kb12669.dasp

Support for ADAMS/Solver (C++)

ADAMS/Vibration is now fully supported by ADAMS/Solver (C++). You may exercise
existing features of ADAMS/Vibration, such as normal modes analysis, forced-vibration
analysis, and modal-energy calculation. Any MSC.ADAMS model that was linearized
with ADAMS/Solver (FORTRAN) can now also be linearized by ADAMS/Solver (C++).
For an example, see Knowledge Base Article 12670:

http://support.adams.com/kb/faq.asp?ID=kb12670.dasp

Support for User-Defined States

The new PSTATE and RM capabilities introduced in ADAMS/Linear (ADAMS/Solver
C++ version) are also fully supported in ADAMS/Vibration. Now your vibration studies
will accurately capture the dependency of eigenvalues on angular velocity for rotating
systems (for example, gyroscopic effects, coriolis effects, and explicit time dependencies).
For further details, see the release notes for ADAMS/Linear on page 33.


http://support.adams.com/kb/faq.asp?ID=kb12669.dasp
http://support.adams.com/kb/faq.asp?ID=kb12670.dasp
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Vibration Design Constraints

New vibration design constraints have been added to complement existing vibration
design objectives. You now have the option of creating design constraints (for
optimization studies) from the following categories:

= Freq. Resp. Magnitude Limit: 1 Input , 1 Output

= Freq. Resp. Magnitude Limit: All Inputs , 1 Output
= Modal Energy: Kinetic Energy

= Modal Energy: Strain Energy

To access this feature, use Vibration > Improve - Vibration Design Constraint > New.

Extended 3D Plotting Support

Support for 3D Frequency Response and Transfer Function plots has been extended to
support the following scenarios:

Table 1. Scenarios for 3D Frequency Response and Transfer Function Plots

Analysis Input Channel(s) Output Channel(s)
single single multiple

single sum selected multiple

single sum all multiple

single multiple single

Linearized MSC.ADAMS Model Export in MSC.Nastran Format (Experimental
Feature)

You can create bulk data files (.bdf) for MSC.Nastran from linearized MSC.ADAMS
models that can be used for performing eigenvalue and frequency response analysis. This
allows you to uses many of the solution sequences available in MSC.Nastran, such as SOL
107 for eigenvalue analysis and SOL 108 for frequency-response analysis.
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You can also export linearized MSC.ADAMS models containing flexible bodies to be
exported as bulk data decks with the flexible body excluded. In MSC.Nastran, these bulk
data decks can then be combined with the original FE bulk data deck from which the
flexible body in the form of an .mnf was derived. You can manually assemble the complete
model (the linearized partial MSC.ADAMS model and the flexible body FE
representation) using constraints (RJOINT) and/or compliant elements, such as CELAS or
CBUSH.

For an example, see Knowledge Base Article 12668:
http://support.adams.com/kb/faq.asp?ID=kb12668.dasp

ADAMS/View

New Units
ADAMS/View now supports the following units:

= Angle - Revolutions

= Force - Micronewton, nanonewton, meganewton

= Linear - Micrometer, nanometer, angstrom, microinch, mils, yard
= Mass - Milligram, microgram, nanogram, us_ton

= Time - Microsecond, nanosecond, day

On-demand Purge of Animation Flexible-Body Cache Files

Flexible-body cache files (.fcf) used to improve the performance of flexible body
animations could accumulate on disk after repeated simulation-animation iterations. You
now can purge the cache files from the disk (Purge Cache Files) using the Tools - Purge
Cache Files menu in both ADAMS/PostProcessor and ADAMS/View.

Generalized Damping of Flexible Bodies

As part of the Nastran-ADAMS Integration effort, this functionality allows you to apply
the generalized damping matrix from MSC.Nastran to an MSC.ADAMS flexible body.
There is an additional option for applying generalized damping in the create and modify
flexible body dialog boxes and the corresponding commands.


http://support.adams.com/kb/faq.asp?ID=kb12668.dasp
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State-dependent Modal Force
You can now create modal forces using a force function to define a load vector.

Plant State (PSTATE) Support

The Plant State object, available in ADAMS/Solver (C++) 2005 r2, is supported in
ADAMS/View with command language and graphical user interface (Build > Controls
Toolkit > Plant State).

Expanded General State Equation (GSE) Interface

To enable ADAMS/Solver (C++) to support implicitly defined general-state equations,
such as those found in MSC.EASY5 models, we’ve added an IMPLICIT keyword to the
command language for general state equations. For more information about implicit
general state equations, refer to the ADAMS/Solver (C++) online help.

Expanded Sensor Interface

To enable ADAMS/Solver (C++) to support systems of equations provided by
MSC.EASYS5 that contain state variables that are not necessarily continuous or
continuously differentiable in time, we’ve added a SWITCH_STATE keyword to the
command language for sensors.

Visual Identification of Durability Hot Spots

When you load the ADAMS/Durability plugin, there is now a Hot Spots tab on the
ADAMS/PostProcessor dashboard in Animation mode. The tab allows you to define the
hot spots and control their display. Using hot spots, you can easily identify locations of
high stress or strain on a flexible body or rigid stress object.

Deleting Unused Markers

Many times models become cluttered with irrelevant or extra markers. A macro has been
implemented to delete any markers that are not being used in a joint, force, request,
parametric expression, or so on.

To access the macro, enter the command:

mdi marker delete_unused body=<rigid or flexible body>

Deselect All
The ability to deselect all current selections has been added to the Edit menu.
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Highlights of Online Help Improvements

We’ve significantly added to the content of the help for each product. We’ve listed the
highlights below.

Overall Online Help Improvements

New search engine — We’ve provided a new search engine, which lets you
enter searches just like popular search engines, such as entering Boolean
characters (AND, NEAR, and so on). It is integrated into the help interface, not
a separate window, and the Search field is always available.

Combined tables of contents (TOCs) - We’ve integrated the TOCs for a
product into one so you do not have to go to different tabs to look for
information.

Improved TOC and search pane — You can now expand and close (in certain
browsers) the pane on the left side of the help window that contains the TOC
and search results. The TOC also contains automatic sync to show you where
your current topic is in the TOC.

Integrated master site — You can now access all product help from one site and
search globally across all products. To access the integrated master site, from
any MSC.ADAMS product, from the Help menu, select MSC.ADAMS Help. You
can also select the All Products button in any product’s online help.

Improved popup definitions — Popup definitions of terms are now positioned
directly over the term they define.

Focused F1 dialog box help — When you press F1 in a dialog box, the help that
appears only shows the help for the dialog box; it does not display the TOC or
extraneous information. To see TOC or search, select Show in the upper left
corner.

More printable versions of reference material — You will find more printable
versions of the reference material for ADAMS/Tire, ADAMS/View,
ADAMS/View Function Builder, and ADAMS/Solver.
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ADAMS/Aircraft

We added three tutorials: Modeling Shimmy in ADAMS/Aircraft, Wheel Analysis, and
Flight with AeroDynamics. We also added new information throughout the
ADAMS/Aircraft help on topics, such as aerodynamics and flexible bodies.

ADAMS/Car

Updated the help to reflect the new functionality, including the theory behind the new
Driving Machine and ADAMS/SmartDriver.

ADAMS/Controls

Updated MSC.ADAMS Extension for MSC.EASYS5 installation procedure. Note that the
documentation on TCP/IP Communication has been moved from the Getting Started
Using ADAMS/Control guide to the online help. It is now searchable and easily accessible
from the product.

ADAMS/Durability

= Shortened Stress/Strain Modes — In previous releases there was some
confusion about how to take advantage of the new shortened stress modes
capability. Now we provide guidance for using shortened stress/strain modes in
recent versions of MSC.Nastran.

= New MSC.Fatigue Tutorial — A new tutorial on using MSC.Fatigue has been
added to the guide, Getting Started Using ADAMS/Durability. It includes
instructions on performing modal stress recovery and fatigue analysis using
MSC.Patran, MSC.ADAMS, MSC.Nastran, and MSC.Fatigue.

= Theory of Modal Stress Recovery — A new theory section has been added to
provide theoretical details of modal stress recovery.

= XDB Help for Stress Recovery — The online help now includes information on
XDB file support of MSC.Nastran-MSC.ADAMS integration. It describes how
to get stresses from orthonormalized mode shapes into the .xdb file.



MSC.ADAMS Release Guide
What's New 55

ADAMS/Solver
Updated the online help to reflect all changes made to the product, including:

= INTEGRATOR statement help includes material on second-order integrators:
HHT and Newmark.

= Information on DXYZ and VXYZ 3D expressions.

ADAMS/Tire
The ADAMS/Tire help has been updated for the new features, including the new tires,
PAC TIME and PAC2002, and additional information. SWIFT Tire documentation is now
in HTML format. The 521 Tire is still in PDF format.
ADAMS/Vibration

= Updated the help to reflect the new Build-Test-Review-Improve menu structure.

= Added new and updated Python scripts.

ADAMS/View

Added help for six more ADAMS/View commands (analysis, geometry, marker, model,
part, and undo).
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Running MSC.ADAMS Products

Starting MSC.ADAMS Products

This section describes how you can start your MSC.ADAMS
products on UNIX and on Windows.

Starting MSC.ADAMS Products on UNIX

The MSC.ADAMS Toolbar is a starting point to using
MSC.ADAMS products on UNIX. The toolbar is shown below.

MSC.ADAMS Toolbar tool - Right-click to
set up Toolbar, manage memory models,
access online help and Technical

Support resources, and more.

e

¢ B=w|=3 Bl o

Product tools - Click to run product or right-click
to configure products and create user libraries.

Hold the cursor over a tool to see the name of
the associated product.

You can also use the MSC.ADAMS Toolbar to:

= Customize, keep track of, and organize multiple libraries
of standard MSC.ADAMS products

= Create binaries
= Manage custom memory models and product preferences

For more information on these or other MSC.ADAMS Toolbar
operations, see the Running and Configuring online help (from the
Help menu in any product, select MSC.ADAMS Help, near the bottom of
the pane on the left, select Running and Configuring MSC.ADAMS).
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To start a product on UNIX:
1 Todisplay the MSC.ADAMS Toolbar, at the command prompt, enter the command
adamsx where x is the version number, for example adams05r2.
2 Click on the tool representing the product you want to start.

Note: We recommend that you use the MSC.ADAMS Toolbar to start your
MSC.ADAMS products, but if you want to automate certain operations,
use the text-based Program Menu. For more information, see the Running
and Configuring online help.

Starting MSC.ADAMS Products on Windows

You start any MSC.ADAMS product from the Start menu. You can also use the Start menu
to:

= Change your license type

= Generate problem reports

= Uninstall products, demonstrations, and documentation
= Set MSC.ADAMS preferences

For more information on these or other operations, see the Running and Configuring
online help.

To start a product on Windows:

= From the Start menu, point to Programs, point to MSC.Software, point to
MSC.ADAMS 2005 r2, point to the name of the product you want to start, and then
select the product type. For example, point to AEngine, and then select ADAMS -
Engine.

Tip:  Select the corresponding desktop icon for the product, if you installed it
on your desktop.
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Setting Preferences

This section describes how you can set preferences, such as your working directory,
graphics setting, and memory model size.

Setting Preferences on UNIX

You use the Registry Editor from the MSC.ADAMS Toolbar to set a variety of
preferences. For information on the preferences you can set, see the Running and
Configuring online help.

To display the Registry Editor:
= From the MSC.ADAMS Toolbar, right-click any product tool, and then select Change
<Product Name> Settings.
Setting Preferences on Windows
You use the Settings menu to modify:
= Graphics settings
= HOOPS settings

= Memory model size

To display the Settings dialog box:

= From the Start menu, point to Programs, point to MSC.Software, point to
MSC.ADAMS 2005 r2, and then select ADAMS - Settings.
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Setting Your Working Directory

During a session in a default or custom product, you can select the directory where you
want to place your model and output files.

For ADAMS/View, you can set the working directory from the Welcome dialog box.
To set your working directory:

1 From the File menu, select Select Directory.

2 Inthe dialog box that appears, select the working directory.



Getting Help

Overview

Learn about the many ways to get help in the MSC.ADAMS
products:

= Tool Tips, 62
= Online Help, 63

= Tutorials and Examples, 72
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Tool Tips

Tool tips display information about the item the cursor is currently over in an
MSC.ADAMS product. The following shows the tool tip that appears when you place the
cursor over the link geometry tool.

x Tool

Ll tip
Al Ak

=| &)

igw Control

| @

2|

To display tool tips:
= Move the cursor over the item in the interface on which you’d like information.

A brief description of the item appears.
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Online Help

To help you use the MSC.ADAMS products, MSC.Software provides online help (HTML
format) and a set of tutorial guides (PDF format). To view the online help and tutorials,
you can use your default Web browser. To read the PDFs along with the help, Acrobat
Reader must be set up as a plugin to the browser, as explained in Configuring Reader on
page 64.

Note: The help for 521 Tire is in PDF format.

The online help shown below is for ADAMS/AutoFlex.

Print View Search
selected help for all across
topic products product help
4 mscadams - Microsoft Internet Explorer 10l =|
File Edit Miew Favorites Tools Help ﬁ
GBack + = - ) \ﬁ\l\@Search @Favorité\ Ehmedia ¢4 | N S5 B
Address I@ FiIe:,fHA:,l’help,l’master,l’!SM&bHeIpImergedProjec Jautoflexfautoflex, htm# afl_home. htm j @Go |Links
Google - | R @Search web ~ \§2 | Bh247blocked Elautoril URdoptions 4
Topics [ contents I scarch— I ——prin_ | 'mnm [owa— @ MSC X SOFTWARE
for product - = ) =
help W A =i
(B velcome to ADAMSAutoFlex Welcome to ADAMS fAutoFlex
IEI Learning the Basics . . .
{B9) Generating Geometry ADAMS/AUtoFlex software is a plugin to ADAMS/View and the
89 Defining Attachment Paints template-based products: ADAMS/Car, ADAMS/Alrcraft,
53 Mociitying Flexible Bodies ADAMS/Engine, and ADAMS/Rail. It allows you to add flexible
{59 Using AutoFlex Manager bodies to your models and achieve more realistic simulation
(B9 £utoFlex Assembler results without using external finite element analysis (FE&)

(B8] ADAMSIALtOF I Files
IEI Exporting ADAMS/AutoFlex Meshes
@ Examples of Using ADAMS/AutoFlex

programs.

ADAMS/Rail. It also assumes that you have a basic
understanding of finite element modeling.

For tutorials introducing you to ADAMS/AutoFlex, see Getting
Started Using ADAMS/AutoFlex,

The ADAMS/AUtoFlex online help assumes that you know how to
run ADAMSMiew, ADAMS/Car, ADAMS/Aircraft, ADAMS/Engine,

Click an entry on the left to learn more about ADAMS/AutoFlex.

or

|

|@ ’_ ’_ ’_ E Local intranet 4




MSC.ADAMS Release Guide
64 Getting Help

Versions of Web Browsers and Adobe Acrobat Reader
We recommend that you view the online help in one of the following browsers:
= Internet Explorer 6 (or higher)
= Netscape Navigator 7 (or higher)
= Mozilla/Firefox 1.0
The help works on Netscape 4.78; however, you may experience slower response times
and the style sheets for defining the look of the help do not work.
Configuring Reader

To view the online guides in PDF format from a Web browser, configure Adobe Acrobat
Reader as a plugin to your browser. To configure Reader as a plugin, go to
http://www.adobe.com/support, and search their knowledge base for instructions. In
particular, see documents:

= 324610 - How to Set Up Netscape Navigator 4.x in UNIX to Display PDF Files
= 313692 - Configuring Netscape Navigator for Windows to Display PDF Files
= 315029 - Configuring Internet Explorer or AOL to Display PDF Files
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Accessing the Online Help

You can view help for a dialog box, a product, or for all MSC.ADAMS products. The

figure below shows the help for all MSC.ADAMS products, called the integrated master
site. You can use this site to view any product’s help and search across all product help.
You can also access frequently asked questions, release notes for all products, and view
the available printable versions.

View

topics for
any product’s
help

\\

(
\»

o
Fle Edt Yew Favortes ook Help ﬁ
Gbak - = - D &t | Disearch GaFavarites @vedn ¢4 | By S B - 5
Address [ asihelpimasterl 3Lt {webHelpimaster.him -] Pw |Linl5

Google - [

|| psearchweb - | 3 | Bhewrblocked  {Eleoorl | fdoptions

L contents N~ Search — I~ Prinl_— ]

[ soarcn - Go] MSC\:'\SOFTWAI\E

~
W

® ADAMS/Aircraft
() ADAMSIAUtoF lex

B9 ADAMS Car RealTime

@ ADAMS/Car

B9 ADAMS Car Ride

B9 ADAMSChassis

(B9 ADAMS Cortrols

@ ADAMSDrivelne

8] ADAME Durability

@ £DAMSEngine

(B ADAMS Flex

B9 2DAMS Mnsight

@ ADAMS/Linear

(B9 ADAMS FostProcessor

@ ADAMERail

@ ADAMS/SmanDriver

(B9 ADAMS Salver

B9 ADAMS Tire:

() ADAMS Mvibration

(B ADAMS Miew

B9 ADAMS Miew Function Builder
B9 Template-Based Products

{89 Running and Configuring MSC.ADAMS
[B9) Helpful Links

@ Incliviciual Product Help

@ Fraquently Asked Guestions

@ Release Notes

@ View Printable Versions

MSC.ADAMS Products

The MSC.ADAMS® suite of software Is the world's most widely used
mechanical systermn simulation software. It enables users to
produce virtual prototypes, realistically simulating the full-motion
behavior of complex mechanical systems on their computers and
quickly analyzing multiple design variations until an optimal design
is achieved. This reducas the number of costly physical prototypes,
improves design quality, and dramatically reduces product
development time.

MSC. ADAMS is part of SimOffice™, M3C's stand-alone YPD
environment, SimCffice provides a unified framework for simulation
of integrated virtual prototypes and includes other major MSC
product families, such as MSC.Nastran.

&) Done

[ | B Locdlintranet 7

To get help on a dialog box:

1 Click in the dialog box for which you need help.

2 Press F1.

MSC.ADAMS launches a browser window that contains information about the
dialog box.

Tip:

To view the help’s table of contents and search buttons, select Show.
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To get general help on your product:

= From your product’s Help menu, select Product Name Help (where Product Name is
the name of your MSC.ADAMS product).

MSC.ADAMS launches a browser window that contains the starting point for
your product’s online help.
To get help on another MSC.ADAMS product:
= Perform one of the following:

— If you’re in an MSC.ADAMS product, from its Help menu, select
MSC.ADAMS Help.

1 If you’re in the help for an MSC.ADAMS product, select the All Products
button from the top of the window.

Your default browser starts and displays the master site for MSC.ADAMS online
help.
To open the MSC.ADAMS online help from the MSC.ADAMS Toolbar:
= Right-click the MSC.ADAMS Toolbar tool, and then select Online Help.
Your default browser starts and displays the master site for MSC.ADAMS online
help.
To open the MSC.ADAMS online help from the Start Menu:

= From the Start menu, point to Programs, point to MSC.Software, point to
MSC.ADAMS x (where x is the release number), and then select ADAMS - Online Help.

Your default browser starts and displays the master site for MSC.ADAMS online
help.



MSC.ADAMS Release Guide
Getting Help 67

Navigating through the Help

You navigate through the MSC.ADAMS help system as you do through any help system,
selecting topics in the pane on the left. In addition, we’ve provided:

= Navigation arrows () = at the top of the pane to let you scroll through topics
one at a time.

= A close button at the top of the pane so you can close the pane and only view
the help topic.

Note: Works only in Internet Explorer.

= Automatic sync to show you where your current topic is in the table of contents
(TOC). This is very helpful if you, for example, search for a topic and want to
know if there are more topics on the subject. It shows you where the topic is in
the TOC, allowing you to see whether or not there are more topics with it.
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Searching

You can search all the help files in HTML format for a particular product or all
MSC.ADAMS products. If a product’s help is in PDF format, you can use the Acrobat
Find tool to search through the PDF.

To search a single product:

1
2

3

Open the online help for your product.

In the Search text box at the top of the help window, enter the search text, and then
press the Go button . (You can also select the Search button @Sz along
the top of the window to display the Search pane and enter text in the pane.)

The results appear in the pane on the left, replacing the table of contents.

Click the topic you want to view.

To search all MSC.ADAMS products:

1

Tip:

At the top of the help window, select the All Products button @ILIIEDS .
The table of contents displays a list of all MSC.ADAMS products.

In the Search text box at the top of the help window, enter the search text, and then
press the Go button .

The results appear in the pane on the left, replacing the table of contents.
Click on the topic you want to view.

Use the AND, OR, NOT, and NEAR operators to precisely define your search by
creating a relationship between search terms. If no operator is specified, AND is
used. For example, the query "'steering suspension subsystem™ is equivalent to
"steering AND suspension AND subsystem." For more information, see the
Frequently Asked Help questions in the online help. For information on accessing
them, see Accessing the Online Help Frequently Asked Questions on page 70.
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Printing
To print a file:

= Display the file, and from the top of the window, select the Print button
. (If you use your browser's print feature, you may end up with

separate printouts of the various frames of the window.) Note that whatever

print method you use, the fonts will print in the same size as displayed on the
screen.

For information that you may want to print all of (such as ADAMS/Solver commands or
the ADAMS/Tire tire models), we’ve provided printable versions of this material in PDF.
You can find printable versions for:

=  ADAMS/Solver (C++) and (FORTAN):
1 Statements
—1 Functions
r—1 Commands
= ADAMS/Solver User-Written and Utility Subroutines
=  ADAMS/View Commands
=  ADAMS/View Functions
—1 Design-Time Functions
—1 Run-Time Functions
=  ADAMS/Tire:
—1 Tire Models
—1 Road Models
—1 User-Written Tire/Road Models
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To print the printable versions:

1 Do one of the following:

1 Display the help for a product, and from the pane on the left, select View
Printable Version.

1 From the master site, near the bottom of the pane on the left, select View
Printable Version.

2 Select the topic whose printable version you want to print.

3 From the Web browser File menu, select Print.

Switching to a Different Product’s Help

You can view any product’s help from the master site. To work with the help from only
one product, you can switch to just that product’s help.

To switch to a different product’s help:

1 Atthe top of any help window, select the All Products button @LEITIESS .

2 From the pane on the left, select Individual Product Help.

3 Select the help you want to view from the list.

Accessing the Online Help Frequently Asked Questions

We’ve provided answers to questions that are frequently asked about the online help, such
as which browsers should | use, how do I set the help so it reuses an existing window, and
how do | print the help.

To view frequently asked questions about the online help:

1 At the top of any help window, select the All Products button @ILEITIESS .

2 Near the bottom of the pane on the left, select Frequently Asked Questions.
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Setting the Location of the Online Help (UNIX Only)

You can change where you store the online help. By default, it is in
finstall_dir/mscsoftware/mscadams/help, where install_dir is the directory in which
MSC.ADAMS is located.

To change the location of the online help:

1
2

Right-click the MSC.ADAMS Toolbar tool, and then select Start Registry Editor.

In the treeview, click the plus sign (+) in front of Toolbar, and then select
Preferences.

Change the value for docsDirectory. For example, to run the online help from a
CD-ROM, change the value to contain CDROM and the subdirectory help
(/CDROM/help).

Viewing the Online Help from CD (UNIX Only)
You can view the online help from the CD on UNIX.

To view the online help from the CD:

1

Insert the MSC.ADAMS Documentation CD into your CD drive.
The CD asks you if you want to install the help.

Exit the installation program.

Right-click the CD labeled Adamshelp2005r2, and then select Open.
A list of files on the CD appear.

Double-click help, and then master.htm.

Your default browser starts and displays the master site for MSC.ADAMS online
help.
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Tutorials and Examples

Each MSC.ADAMS product has a set of tutorials or getting started guides that step you
through examples of using the product’s features, as well as introduces the basic concepts
of the product. The getting started guides are online. In addition, many of the products
have examples of its features that are stored in Knowledge Base Articles.

You will find links to all the tutorials and examples for a product under its Examples tab.

To access the tutorials and examples:

= From the online help for a product, from the pane on the left, select Examples.



Supported Versions of Integrated
Products

Overview

The tables on the next pages list the versions of products that work
with MSC.ADAMS 2005 r2. In addition, there are notes on using
MSC.EASY5 and MATLAB.

= Support for MSC.EASY5 and MATLAB, 74
= MSC.Software Integrated Products, 75

= Other Integrated Products, 76
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Support for MSC.EASY5 and MATLAB

MSC.EASYS

This release of ADAMS/Controls is certified to run with MSC.EASY5 2005 r1. Note
MSC.EASY5 2005 r1 does not support SGI-IRIX and HP-Itanium (IA64).

Platform support is subject to change. For the latest information, see the MSC.EASY5
2005 r1 Hardware and Software Requirements at:

http://www.mscsoftware.com/support/prod_support/easy5/?Q=135&7=144&Y=208

Note: If you want to co-simulate with MSC.EASY5 and you are running
ADAMS/Controls on one of the platforms that MSC.EASY5 does not support,
you should consider using TCP/IP communication. This allows ADAMS/Controls
to communicate with MSC.EASY5 even though the codes are running on
different platforms.

MATLAB

The supported version of MATLAB is R14 SP2 (MATLAB 7.0.4, Simulink 6.2.1).
ADAMS/Controls 2005 r2 does not officially support older MATLAB versions, such as
R14 and R13.1 (MATLAB 6.5.1, Simulink 5.1.1), although they have been tested and are
working. Note that MATLAB R14 SP2 does not support IBM and HP-Itanium (1A64)
platforms. For more information on R14 platforms and compatibility, see:

http://www.mathworks.com/support/sysreg/current_release/unix.html

Note: If you want to co-simulate with MATLAB and you are running ADAMS/Controls
on one of the platforms that is not supported by MATLAB, you should consider
using TCP/IP communication. This allows ADAMS/Controls to communicate
with MATLAB even though the codes are running on different platforms.

For further information regarding UNIX platform support for ADAMS/Controls, see
Knowledge Base Article 12445:

http://support.adams.com/kb/fag.asp?ID=kb12445.dasp


http://www.mscsoftware.com/support/prod_support/easy5/?Q=135&Z=144&Y=208
http://www.mathworks.com/support/sysreq/current_release/unix.html
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Table 2. MSC.Software Integrated Products

Product name and
version:

MSC.EASY5
2004.1

MSC.Nastran 2001
and 2004 (Bulk
Data Export)

MSC.Nastran 69.X
and above

MSC.Fatigue 2001
and above

MSC.Marc
* 2005
* 2003 and above

MSC.ADAMS product:

ADAMS/Controls

ADAMS/AutoFlex

« ADAMS/Durability
* ADAMS/Flex*

ADAMS/Durability

« ADAMS/Durability
* ADAMS/Flex

Platform:

UNIX and Windows

UNIX and Windows

UNIX and Windows

UNIX and Windows

UNIX and Windows




76

MSC.ADAMS Release Guide
Supported Versions of Integrated Products

The following table lists those products that MSC.ADAMS works with that are from other

vendors.
Table 3. Other Integrated Products
Company: Product nameand MSC.ADAMS product: Platform:
version:
ANSYS, Inc. ANSYS « ADAMS/Durability UNIX and Windows
¢ 6.0 and above « ADAMS/Flex
* 5.4 and above
Hibbitt, ABAQUS/ADAMS < ADAMS/Durability ~ UNIX and Windows
Karlsson & e 6.3 ADAMS/Flex
Sorensen, Inc. and above
(HKS)  6.1-1
and above
nCode FE-Fatigue 5.2 ADAMS/Durability UNIX and Windows
and above
The Release 13 SP1 ADAMS/Car RealTime « Windows 2000
MathWorks, « MATLAB6.5.1 Standalone ¢ Windows XP
Inc. e Simulink 5.1.1 and Embedded Professional
The Release 14 ADAMS/Car RealTime ¢ Red Hat Linux 9.0
MathWorks, « MATLAB 7 Standalone and Red
Inc. e Simulink 6 Embedded » Hat Enterprise
Linux 3
The Release 13 SP1 ADAMS/Controls e HP HP-UX 11, 11i
MathWorks, « MATLAB6.5.1 ¢ HP Intel Itanium 2
Inc. e Simulink 5.1.1 * SGI IRIX 6.5.14
¢ Real-Time

Workshop 5.1.1
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Table 3. Other Integrated Products (continued)

Company:

The
MathWorks,
Inc.

TNO
Automotive

UGS
PLM
Solutions

Product name and
version:

Release 14

« MATLAB7

e Simulink 6

* Real-Time
Workshop 6

MF-Tool
2.2 and above

I-DEAS
Mechanism Design
» |I-DEAS NX 10
and above
» |-DEASS8, 9, NX
10,
and above

MSC.ADAMS product:

ADAMS/Controls

ADAMS/Tire

» ADAMS/Durability

» ADAMS/Flex

Platform:

* Red Hat Linux 9.0
¢ Red Hat Enterprise

Linux 3

¢ Sun Solaris 8, 9
* Windows 2000
* Windows XP

Professional

UNIX and Windows

UNIX and Windows

* ADAMS/Flex is not compatible with MSC.Nastran for Windows.
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MSC.ADAMS
and virtual product development 7
highlights 14
licensing 9
new products 16
platforms supported 15
starting products 57

MSC.ADAMS Toolbar
about 57
starting online help from 66

MSC.EASYS5, support for 74
MSC.MasterKey licensing, about 9

MSC.Software
about 7
consulting services 11
contacting 9
licensing 9

N

Navigating through online help 67
Netscape Navigator version for help 64
New products for 2005 r2 16



MSC.ADAMS Release Guide
Index

83

0]

Obtaining
consulting services 11
technical support 10
training 11
Online help
about 63
accessing 65
accessing frequently asked questions 70
improvements 53
navigating through 67
printing 69
searching single product 68
setting location of 71
switching to different product’s 70
viewing on CD 71

Operators for Boolean searches 68

|

Platforms supported 15
Preferences, setting 59
Printable versions of product help 69
Printing online help 69

Products
additions to 17
new for 2005 r2 16
starting MSC.ADAMS 57
versions of integrated 73

R

Registry Editor
about 59
using to set location of online help 71



84

MSC.ADAMS Release Guide
Index

S

Sales and services offices 10
Scrolling through help 67

Searching
all products 68
online help 68

Setting
location of online help 71
preferences 59
working directory 60

Starting
MSC.ADAMS products 57
online help 65

Supported
MATLAB 74
MSC.EASY5 74
platforms 15

Switching to different product’s help 70

T

Technical support, obtaining 10
Token-based licensing 9

Tool tips, displaying 62
Traditional licensing 9
Training, obtaining 11
Tutorials, accessing 72



MSC.ADAMS Release Guide
Index

85

U

UNIX
setting location of online help 71
setting preferences on 59
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viewing online help on 71
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Viewing all product help 65
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